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Getting Started 

DriveTrain Toolkit can design the mechanical system composed of shaft, gear, bearing, etc. It 

can consider the material and dynamic properties of its parts. For shaft, it can design and 

analyze the shaft with the various radii using the FE Beam Element. For gear, it co-simulates 

with KISSsoft for more accurate and detailed result and it can be used with Involute Analytic 

Gear Contact for reduced simulation time with accurate result. For bearing, it also co-

simulates with KISSsoft for more accurate and detailed result. 

In this tutorial, you will learn about the process of simulation of gearbox system using 

DriveTrain Toolkit. You can learn how to use the new functions and analyze the simulation 

results. 

 

 

 

Objective 

You will also learn below. 

▪ Create a shaft, bearing, gear 

▪ Create an analytic gear contact 

▪ Analyze the simulation result of shaft, bearing, gear 

  

Chapter 

1 
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Prerequisites 

This tutorial is for the users who already learned the basic tutorial and the FFlex tutorial. 

Therefore, you should first work through the tutorials that mentioned earlier to enhance the 

understanding of this tutorial. Also, we assume that you have a basic knowledge of dynamics 

and the Finite Element Method. 

 

Procedures 

This tutorial is comprised of the following procedures. The estimated time to complete each 

procedure is shown in the table below. 

Procedures  Time (minutes) 

Simulation environment setup 10 

Create shaft 10 

Create bearing 10 

Create gear 15 

Create joint, force 20 

Analyze the simulation result 20 

Create involute analytic contact 20 

Total 105 

 

Estimated Time to Complete 

1 hours and 45 minutes  
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Setting Up the Simulation 

Environment 

Task Objective 

In this chapter, you will start the RecurDyn and setup its environment, including importing 

the completed gearbox CAD and changing its names and layer. 

 

Estimated Time to Complete 

15 minutes 

  

Chapter 
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Starting the RecurDyn 

To start the RecurDyn and create a new model:   

1. On your Desktop, double-click the RecurDyn 

icon and the New Model dialog box will 

appear. 

2. Change the Model Name to GearBox as 

shown at right. 

3. Ensure the units are the same as those in the 

Start RecurDyn dialog box shown at right. 

If not, click MMKS. 

(Millimeter/Kilogram/Newton/Second) 

4. Click OK.  

 

 

Importing the Gearbox Geometry 

You will begin to model the gearbox by importing an already completed gearbox CAD. 

To import the gearbox CAD 

1. From the File menu, Choose Import.  

2. In the Open dialog box, select the file GearBoxCAD.x_t. (The file location: 

<InstallDir>/Help/Tutorial/Toolkit/DriveTrain/GearBox). 

3. Click Open. The CAD Import Options dialog appears. Make sure the option Assembly 

Hierarchy is checked and the option Body is checked in the Hierarchy Conversion 

Level and click Import. 
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To change the name of CAD and set layer 

1. Right-click the Upper Housing body as shown in the figure below and click Properties 

in the Pop-up menu. 

2. In the General tab, you will adjust the value using the information below and click OK. 

▪ Name: UpperHousing 

▪ Layer: 2 

3. For the Lower Housing body, change the Name to LowerHousing and Layer to 2. 
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Adjusting the Icon, Marker Size and Layer 

To adjust the icon and marker size 

1. In the Render Toolbar, click the Icon Control as shown in 

the figure below. 

 

2. Set the Icon Size and Marker Size to 25 as shown at 

right. 

 

 

 

 

 

 

To adjust the layer setting  

1. In the Render Toolbar, click Layer Settings as shown 

in the figure below. 

2. Change the Name of Layer 2 to Housing and Check 

Off the Layer On option as shown at right. 
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The model appears as shown in the figure below.  

 

Saving the Model 

Take a moment to save your model before you continue with the next chapter. (Tip: From 

File menu, click Save.)  
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Creating the Shaft 

Task Objective 

In this chapter, you will learn how to use the shaft modeler that can create various types of 

shaft sections which are composed of finite beam element with different circular cross 

sections. 

 

Estimated Time to Complete 

10 minutes 

  

Chapter 
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Creating the Shaft 

You will create the shaft with beam element to analyze the stress and deformation of shaft 

in gearbox system. 

To create the Shaft1 

Shaft Modeler in RecurDyn defines the section as parts with same radius, length and 

material. Number of shaft section increases from starting point towards axial direction. 

Design of the Shaft1 is shown in the figure below. 

 

1. From the Shaft group in the DriveTrain tab, click Shaft. 

2. Set the creation method to Point, Direction, WithDialog and input the value using 

following information. 

▪ Point: -255, 250, 175 

▪ Direction: 1, 0, 0 

3. After Shaft dialog appears, click Add button 3 times to make 4 Sections and adjust the 

values using following information. 

Section L Ro Ri Element Size 

1 120 42.5 0 10 

2 160 75 0 10 

3 230 42.5 0 10 

4 200 39 0 10 
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4. Click FDR button which is located next to the Sections box. After FDR dialog appears, 

click Add button 3 times to make 3 FDRs and adjust the values using the following 

information. 

No Center Position Width Type 

1 22.5 41 RBE2 

2 200 120 RBE2 

3 487.5 41 RBE2 

5. Click Close to exit FDR dialog. 

6. Click OK to create Shaft. 

7. Delete the existing Shaft body where Shaft1 has been created. 

 

Note: FDR  

Most of the time Shafts are attached with the machine elements like gear, bearing, etc. 

Connectors like pin, key, spline, snap ring are used to attach those elements. In RecurDyn, 

connections of these machine element are expressed as FDR element which is rigid element.  

If you look at the center position of the FDR which is master node, you can see that the size of 

master node is bigger than the size of other nodes. 

 

Note: FDR Tolerance 

When you create a FDR element, 3 nodes, center position and two end sides of FDR, are added 

to the existing nodes. The distance between existing node and the added FDR node can be 

very small. The FDR Tolerance is used to ignore the small element caused by creation of FDR. 

For example, if FDR Tolerance is 0.01 and the distance between two nodes are 0.009, the 

added FDR Element is ignored and altered as existing node. 

 

To create the Shaft2 

Create the Shaft2 using same method as above using the following information. 

1. Point, Direction, WithDialog  

▪ Point: -255, 250, -105 

▪ Direction: 1, 0, 0 

2. Shaft Section  

Section L Ro Ri Element Size 

1 50 32.5 0 10 

2 235 37.5 0 10 

3 125 50 0 10 

4 100 32.5 0 10 
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3. FDR Section  

No Center Position Width Type 

1 22.5 33 RBE2 

2 200 120 RBE2 

3 347 90 RBE2 

4 487.5 33 RBE2 

 

To create the Shaft3 

Create the Shaft3 using same method as above using the following information  

1. Point, Direction, WithDialog  

▪ Point: -402, 250, -325 

▪ Direction: 1, 0, 0 

▪  

2. Shaft Section  

Section L Ro Ri Element Size 

1 657 30 0 10 

 

3. FDR Section  

No Center Position Width Type 

1 169.5 22 RBE2 

2 494 90 RBE2 

3 634.5 22 RBE2 
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The model appears as shown in the figure below. 

 

 

Saving the Model 

Take a moment to save your model before you continue with the next chapter. (Tip: From 

File menu, click Save.) 
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Creating the Bearing 

Task Objective 

In this chapter, you will learn how to create a Ball Bearing using a KISSsoft Ball Bearing 

Library. 

 

Estimated Time to Complete 

10 minutes 

  

Chapter 

4 
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Creating the Bearing 

You will create a KISSsoft Ball Bearing to analyze the dynamic behavior of the Ball 

Bearing that attached to the shaft. 

To create the BearingGroup1, 2  

1. From the KISSsoft group in DriveTrain tab, click Bearing. 

2. Set the creation method to Point, Direction, WithDialog and input the value using 

following information. 

▪ Point: 232.5, 250, 175 

▪ Direction: 1, 0, 0 

3. After the Bearing dialog appears, click the Library button next to the Bearing Library. 

 

4. After the Bearing Library dialog appears, adjust the values using the following 

information. 

▪ Bearing Type: Deep groove ball bearing (single row) 

▪ Diameter: (Inside) 85.000 mm 

▪ Bearing: Timken 6317 (d=85.000 mm, D=180.000 mm, B=41.000 mm) 

▪ Internal Clearance: C2 

 

5. Click OK to close the Bearing Library dialog. 

6. Click OK in the Bearing dialog to create BearingGroup1. 

7. Delete the existing Bearing body where the BearingGroup1 has been created. 

8. Repeat the Step 1~7 but change the Point value in the Step 2 as (-232.5, 250, 175). 

 

To create the BearingGroup3, 4 

Create the BearingGroup3, 4 using same method as above using the following information. 
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1. Point, Direction, WithDialog  

▪ Point: (232.5, 250, -105), (-232.5, 250, -105) 

▪ Direction: 1, 0, 0 

2. Bearing Library 

▪ Bearing Type: Deep groove ball bearing (single row) 

▪ Diameter: (Inside) 65.000 mm 

▪ Bearing: Timken 6313 (d=65.000 mm, D=140.000 mm, B=33.000 mm) 

▪ Internal Clearance: C2 

 

To create the BearingGroup5, 6  

Create the BearingGroup5, 6 using same method as above using the following information. 

1. Point, Direction, WithDialog  

▪ Point: (232.5, 250, -325), (-232.5, 250, -325) 

▪ Direction: 1, 0, 0 

2. Bearing Library 

▪ Bearing Type: Deep groove ball bearing (single row) 

▪ Diameter: (Inside) 60.000 mm 

▪ Bearing: Timken 6212 (d=60.000 mm, D=110.000 mm, B=22.000 mm) 

▪ Internal Clearance: C2 
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The model appears as shown in the figure below. 

 

 

Saving the Model 

Take a moment to save your model before you continue with the next chapter. (Tip: From 

File menu, click Save.)  
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Creating the Gear 

Task Objective 

In this chapter, you will create a Gear Pair using a KISSsoft Gear Train. 

 

Estimated Time to Complete 

15 minutes 

  

Chapter 
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Creating the Gear 

You will create a KISSsoft Gear Train to analyze the dynamic behavior of a gear in a gearbox 

system. 

To create a CylindricalGearGroup1 

1. From the KISSsoft group in the DriveTrain tab, click GearTrain. 

2. Set the creation method to Point, Point, Direction, WithDialog and input the value 

using the following information. 

▪ Point: -55, 250, 175 

▪ Point: -55, 250, -105 

▪ Direction: 1, 0, 0 

3. After the CylindricalGear dialog appears, input the values in the Gear Geometry 

section using the following information. 

▪ Normal Module: 5 

▪ Gear Type: Helix Right Hand 

▪ Helix Angle at Reference Circle: 20 

4. For rest of the parameters of Gear1, 2, input the values using following information. The 

dialog will appear as shown in the figure below. 

Gear No. of Teeth Face Width Profile Shift Coefficient 

1 73 120 0.4405 

2 31 120 0.2477 

 

 

5. Click the ‘…’ button in the Details of Gear1. Change the Inner Diameter value to 150 

and click Close to exit the dialog. Change the Inner Diameter of Gear2 to 75 using 

above method. 

6. Click the ‘…’ button in the Tolerance of Gear1. After [Gear 1] Tolerance dialog 

appears, input the value using following information and click Close to exit the dialog. 

▪ Tooth Tolerance Type: User Input 

▪ Tooth Thickness (Upper/Lower): (0, 0) 

▪ Tip Diameter (Upper/Lower): (Check) (0, 0) 

▪ Root Diameter (Upper/Lower): (Check) (0, 0) 
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▪ Then the dialog appears as shown in the figure below. 

 

Note: Tooth Tolerance 

In the Tolerance dialog, you set the tolerances of tooth thickness, tip diameter and root 

diameter. If you set the Upper / Lower value as 0, it means no tolerance in gear shape. If you 

set the Upper / Lower values, KISSsoft automatically calculate the appropriate value between 

the upper and lower limit. 

 

7. Repeat the Step 6 to the Tolerance of Gear2. 

8. In Gear Pair section, change the Center Distance value to 280 and click the Calc. 

button in the Backlash to calculate backlash. 

 

 

 

Note: Contact Analysis 

In Contact Analysis dialog, the Number of Meshing Positions determines the number of 

calculation following the Path of Contact between a meshing teeth pair. The Number of Slices 

determines the number of axial cross sections of gear pair where the Meshing Position is 

calculated. For example, if you set the Number of Meshing Position as 17 and 11 as the Number 

of Slices, the 17 meshing positions are distributed evenly throughout the path of contact in 

each one of 11 slices while the surface of gear tooth contacts the tooth surface of other gear. 
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Note: Difference between RecurDyn Gear Toolkit  

The Gear Train dialog in DriveTrain Toolkit is created based on the KISSsoft User Interface. 

Some of the nomenclature is different from the RecurDyn Gear Toolkit. Below is the comparison 

of those parameters that has the same meaning but different names. 

 

 

Then, the CylindricalGear dialog appears as shown in the figure below. 

 

 

KISSsoft RecurDyn 

Normal Module Module 

Pressure Angle at Normal Section Pressure Angle 

Helix Angle at Reference Circle Helix Angle 

Face Width Gear Width 

Profile Shift Coefficient Addendum Modification Coefficient 

Inner Diameter Hole Radius 

Dedendum Coefficient Dedendum Factor 

Root Radius Coefficient Hob Rack Radius Coefficient 

Addendum Coefficient Addendum Factor 
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9. Click OK in CylindricalGear dialog to create CylindricalGearGroup1. 

10. Delete the existing Gear body where the CylindricalGearGroup1 has been created. 

 

Note: Gear Modification 

If you click the Modification button, you can create the various types of tooth modification. 

Profile/Tooth Modification has different input value regarding its type. For detailed information, 

refer to the manual. (DriveTrain > Functions for DriveTrain > KISSsoft > Gear Train > 

Properties > Modification) 

 

To create a CylindricalGearGroup2 

Create the second Gear Pair using same method as above using following information.  

1. Point, Point, Direction, WithDialog  

▪ Point: 92, 250, -105 

▪ Point: 92, 250, -325 

▪ Direction: 1, 0, 0 

2. Gear Geometry  

▪ Normal Module: 5 

▪ Gear Type: Helix Right Hand 

▪ Helix Angle at Reference Circle: 20 

Gear No. of Teeth Face Width Profile Shift Coefficient 

1 59 90 0.2193 

2 23 90 0.1595 

 

3. Inner Diameter  

▪ Gear1: 100 

▪ Gear2: 60 

4. Gear1, Gear2 Tolerance  

▪ Tooth Tolerance Type: User Input 

▪ Tooth Thickness (Upper/Lower): (0, 0) 

▪ Tip Diameter (Upper/Lower): (Check) (0, 0) 

▪ Root Diameter (Upper/Lower): (Check) (0, 0) 

5. Change the Center Distance to 220 and click Calc. button of Backlash. 
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To adjust the Contact 

1. In the Database, right-click the CylindricalGearGroup1 and click Properties in the 

Pop-up Menu. 

2. In the Gear Pair section, Click the … button in the Meta Model. 

 

3. Check the Import Meta Model File(*.gmm) and click the … button. 

4. Open the GearBox_GearForce1.gmm file from directory below. 

▪ <InstallDir>\Help\Tutorial\Toolkit\DriveTrain\GearBox 

5. Close the Meta Model dialog. 

6. Set the Gear Force Type to KISSsoft Force (Meta Model) as figure below. 

 

7. Click OK to close the dialog. 

8. Repeat the Step 1~7 for the CylindricalGearGroup2 but changing the file to 

GearBox_GearForce2.gmm. 

Then, model appears as shown in the figure below. 
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Saving the Model 

Take a moment to save your model before you continue with the next chapter. (Tip: From 

File menu, click Save.)  
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Creating the Joint and Force 

Task Objective 

In this chapter, you will create the Joints and Forces. 

▪ Fixed Joint between Ground and Housing 

▪ Fixed Joint between Housing and Outer Bearing 

▪ Fixed Joint between Shaft and Inner Bearing 

▪ Revolute Joint between Ground and Shaft 

▪ Rotational Axial Force between Ground and Shaft 

 

Estimated Time to Complete 

20 minutes 

  

Chapter 

6 
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Creating the Expression 

You will create the expression which will be applied to Joints and Forces, 

1. From the SubEntity tab, click Expression. 

2. In the Expression List dialog, click Create. 

3. In the Expression dialog, create the expression using the following information. 

Name Expression 

Ex_Vel 10*pi*time 

Ex_Torque -640000 

 

Creating the Joint 

To create the fixed joint 

1. From the Joint group in the Professional tab, click Fixed Joint. 

2. Set the creation method to Body, Body, Point and input the value using the following 

information.  

▪ Body: Ground 

▪ Body: LowerHousing 

▪ Point: 245, -5, 485 

3. Create the Fixed Joint between the Housing and Bodies using the following 

information. 

Name Body Body Point 

Fixed1 Ground LowerHousing 245, -5, 485 

Fixed2 LowerHousing UpperHousing 205, 250, 500 

Fixed3 LowerHousing BearingOuterBody1 232.5, 250, 175 

Fixed4 LowerHousing BearingOuterBody2 -232.5, 250, 175 

Fixed5 LowerHousing BearingOuterBody3 232.5, 250, -105 

Fixed6 LowerHousing BearingOuterBody4 -232.5, 250, -105 

Fixed7 LowerHousing BearingOuterBody5 232.5, 250, -325 

Fixed8 LowerHousing BearingOuterBody6 -232.5, 250, -325 
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4. Create the Fixed Joint between the Shaft and body using the following information. 

Name Body Body Point 

Fixed9 Shaft1 BearingInnerBody1 232.5, 250, 175 

Fixed10 Shaft1 CylindricalGear1 -55, 250, 175 

Fixed11 Shaft1 BearingInnerBody2 -232.5, 250, 175 

Fixed12 Shaft2 BearingInnerBody3 232.5, 250, -105 

Fixed13 Shaft2 CylindricalGear2 -55, 250, -105 

Fixed14 Shaft2 CylindricalGear3 92, 250, -105 

Fixed15 Shaft2 BearingInnerBody4 -232.5, 250, -105 

Fixed16 Shaft3 BearingInnerBody5 232.5, 250, -325 

Fixed17 Shaft3 CylindricalGear4 92, 250, -325 

Fixed18 Shaft3 BearingInnerBody6 -232.5, 250, -325 

 

To create the revolute joint 

You will create the Revolute Joint to set the motion in the gearbox. 

1. From the Joint group in the Professional tab, click Revolute Joint. 

2. Set the creation method to Body, Body, Point, Direction and input the value using 

following information. 

▪ Body: Ground 

▪ Body: Shaft3 

▪ Point: -402, 250, -325 

▪ Direction: 1, 0, 0 

3. Create the Revolute Joint between the Shaft and Ground using the following 

information. 

Name Body Body Point Direction 

RevJoint1 Ground Shaft3 -402, 250, -325 1, 0, 0 

RevJoint2 Ground Shaft1 455, 250, 175 1, 0, 0 
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To adjust the motion 

You will set the Motion in the RevJoint1.  

1. In the Database, right-click the 

RevJoint1 and click the Properties in 

the Pop-up menu. 

2. Check the Include Motion and click 

Motion. 

3. Change Displacement (time) to 

Velocity (time) and click EL. 

4. Select Ex_Vel and click OK. The dialog 

appears as shown right. 

 

Creating the Force 

To create the rotational axial force  

You will create the Rotational Axial Force to set the input torque of gearbox. 

From the Force group in the Professional tab, click Rotational Axial Force. 

1. Set the creation method to Joint as shown in the figure below. 

 

2. Click RevJoint1 to create RotationalAxial1. 

 

To create the rotational axial force 

1. In the Database, right-click the RotationalAxial1 and click the Properties in the Pop-

up menu. 

2. In the Rotational Axial Force tab, click the EL button. 

3. After Expression List dialog appears, select Ex_Torque by clicking it and click OK. 

4. Click OK to close the dialog.   
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Performing Dynamic/Kinematic Analysis 

In this section, you will run a dynamic/kinematic analysis to view the effect of forces and 

motion on the model you just created. 

1. From the Simulation Type group in the Analysis tab, click Dyn/Kin. 

2. In the General tab, define the end time of the simulation and number of steps: 

▪ End Time: 2 

▪ Step: 5000 

▪ Plot Multiplier Step Factor: 2 

3. Click Simulate. It will take approximately 3 minutes to complete the analysis. (CPU: 

Intel® Core™ i7-6700K CPU @ 4.00GHz) 
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Analyzing the Simulation Result  

Task Objective 

In this chapter, you will analyze the result of gearbox simulation. 

 

Estimated Time to Complete 

20 minutes 

  

Chapter 

7 
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Analyzing the Shaft 

Adjust the icon control  

1. In the Render Toolbar, click Icon Control as shown in 

the figure below.  

 

2. Check Off the All Icons, All Markers and Inertia 

Reference Frame as shown at right. 

 

Adjust the rendering mode 

1. In the Render Toolbar, click Wireframe with 

Silhouettes. 

 

 

Adjust the contour  

1. From the Shaft group in the DriveTrain tab, click Contour. 

2. In the Contour Option, change the Type as Stress and Component as SMISES. 

3. In the Style option, change the Style from Stepped to Smooth. 

4. In the right-side of the dialog, check off the Shaft2, Shaft3 in the View/Reference 

Node/Reference Marker. 

5. Click the Calculation button, check the Show Min/Max option and click OK. 

Then, the Contour dialog appears as shown in the figure below.  
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To play an animation 

1. From the Animation Control group in the Analysis tab, click Play. 

Then, maximum stress occurs in the Shaft1 after 36 frames. 
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To view the shaft1 scope  

1. From the Shaft group in the KISSsoft tab, click Scope Control. 

2. After the Shaft Scope Control dialog appears, check Use option next to the Shaft1 

and click Display.  

3. After the Shaft Scope – Shaft1 dialog appears, adjust the Component as SMISES. 

4. Make sure the Synchronize with Animation Control option is checked in the 

Animation Frame section. 

5. From the Animation Control group in the Analysis tab, click Animation Play. 

Then, you can see the changes of the SMISES of Shaft1 with Animation as shown in 

the figure below. 
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Analyzing the Bearing 

1. From the Plot group in the Analysis tab, click Plot Result.  

2. From the Windows group in the Home tab, click Show All 

Windows. 

3. In the Plot Database, click the ‘+’ button next to the Force. 

4. Click the ‘+’ button next to the DriveTrain_BearingForce. 

5. Click the ‘+’ button next to the BearingForce1. 

6. Click the upper-left pane of the Plot Window and double-click the FM_Bearing from 

the Plot Database. 

7. Click the upper-right pane of the Plot Window and double-click the TM_Bearing from 

the Plot Database. 

8. Repeat the Step 5~7 for the BearingForce2~6. 

Then, Plot Window appears as shown in the figure below. 

 

 

Analyzing the Gear 

1. Click the ‘+’ button next to the DriveTrain_GearForce. 

2. Click the each ‘+’ button next to the GearForce1 and GearForce2. 

3. Click the lower-left pane of the Plot Window and double-click the 

TransmissionError_Angular from the GearForce1. 

4. Click the lower-right pane of the Plot Window and double-click the 

TransmissionError_Angular from the GearForce2. 

Then, Plot Window appears as shown in the figure below. 
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Involute Analytic Contact 

Task Objective 

In this chapter, you will learn how to use the Involute Analytic Contact. 

 

Estimated Time to Complete 

20 minutes 

  

Chapter 

8 
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Creating the Involute Analytic Contact 

Return to the GearBox model, you will learn how to use 

RecurDyn Involute Analytic Contact instead of KISSsoft 

Gear Contact. 

Adjust the icon control  

1. In the Render Toolbar, click Icon Control as shown in 

the figure below. 

 

2. Check the Contact as shown at right. 

 

 

 

Inactive the kisssoft gear contact  

1. In the Database, right-click the CylindricalGearGroup1 and click Property in the 

Pop-up menu. 

2. Change the Gear force Type option to Inactivate at the bottom of Property dialog. 

3. Click OK to close the dialog. 

4. Repeat the Step 1~3 for the CylindricalGearGroup2. 

 

To create the involute analytic contact 

1. From the Contact group in DriveTrain tab, click Involute Analytic Contact. 

2. Set the creation method to KISSsoft body, KISSsoft body and select the 

CylindricalGear1 and CylindricalGear2. 

3. Repeat the Step 1~2 for the CylindricalGear3, CylindricalGear4. 

 

To adjust the involute analytic contact 

1. In the Database, right-click the GearContactInvolute1 and click Property in the Pop-

up menu. 

2. In the Gear Involute Contact tab, adjust the values using the following information. 

▪ No. of Slices in Width: 31 

▪ No. of Maximum Involute Profile: 10 

3. In Advanced Option, check Tooth Flexibility. 

4. Repeat the Step 1~3 for the GearContactInvolute2. 
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Performing Dynamic/Kinematic Analysis 

In this section, you will run a dynamic/kinematic analysis to view the effect of Involute 

Analytic Contact on the model you just created. 

1. From the Simulation Type group in the Analysis tab, click Dyn/Kin. 

2. Click Simulate.  

 

Analyzing the Shaft 

To view the shaft1 scope 

1. From the Shaft group in the KISSsoft tab, click Scope Control. 

2. After the Shaft Scope Control dialog appears, check Use option next to the Shaft1 

and click Display. 

3. After the Shaft Scope – Shaft1 dialog appears, adjust the Component as SMISES. 

4. Make sure the Synchronize with Animation Control option is checked in the 

Animation Frame section. 

5. From the Animation Control group in the Analysis tab, click Animation Play 

Then, you can see the changes of the SMISES of Shaft1 with Animation as shown in 

the figure below. 

The graph is almost same as the SMISES graph from Chapter 7. 
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Analyzing the Bearing 

1. From the Plot group in the Analysis tab, click Plot Result.  

2. From the Windows group in the Home tab, click Show All 

Windows. 

3. In the Plot Database, click the ‘+’ button next to the Force. 

4. Click the ‘+’ button next to the DriveTrain_BearingForce. 

5. Click the ‘+’ button next to the BearingForce1. 

6. Click the upper-left pane of the Plot Window and double-click the FM_Bearing from 

the Plot Database. 

7. Click the upper-right pane of the Plot Window and double-click the TM_Bearing from 

the Plot Database. 

8. Repeat the Step 5~7 for the BearingForce2~6. 

Then, Plot Window appears as shown in the figure below  

 

 

Analyzing the Gear 

1. Click the ‘+’ button next to the Contact. 

2. Click the ‘+’ button next to the Gear Involute Contact. 

3. Click the each ‘+’ button next to the GearContactInvolute1 and 

GearContactInvolute2. 

4. Click the lower-left pane of the Plot Window and double-click the 

TransmissionError_Angular from the GearContactInvolute1. 

5. Click the lower-right pane of the Plot Window and double-click the 

TransmissionError_Angular from the GearContactInvolute2. 

Then, Plot Window appears as shown in the figure below. 
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Campbell Diagram 

Task Objective 

In this chapter, you will learn how to use the Campbell Diagram. 

 

Estimated Time to Complete 

20 minutes 

 

  

Chapter 

9 
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Simulate the Campbell Diagram Model 

You will open and simulate the already saved Campbell Diagram model. 

To open the Campbell Diagram model 

1. From the File menu, click Open.  

2. From the Drivetrain tutorial directory, select the file Capmbell_Diagram.rdyn. 

▪ Path: <InstallDir>\Help\Tutorial\Toolkit\Drivetrain\GearBox 

3. Click Open. 

The model appears as shown in the figure below. 

 

 

To save the Campbell Diagram model 

1. From the File menu, click Save As. 

2. Save the model in different directory, because you cannot simulate in tutorial directory. 

 

To simulate the Campbell Diagram model 

You will run the Dynamic/Kinematic analysis because the model is already set. 

1. From the Simulation Type group in the Analysis tab, click Dyn/Kin. 

2. Click Simulate. It will take approximately 30 seconds to complete the analysis. (CPU: 

Intel® Core™ i7-6700K CPU @ 4.00GHz) 

 

Adjusting the Analysis Tab 

To adjust the Input Data 

1. From the Plot group in the Analysis tab, click Plot Result.  

2. From Tool tab, click Campbell (3D).  
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3. In Plot Database, expand the Request\Expression\ExRq1. 

4. Drag & Drop the F1(Ex_Tacho) in the Tacho from Input Data. 

5. Drag & Drop the F3(Ex_Signal) in the Signal from Input Data. 

6. Click the Update Signal Information to update the below parameters. 

 

 

To adjust the Frame Settings 

1. Check off the Use Recommended Frame Settings. 

2. Change Frame Size to 128. 

3. Click Advanced Setting. 

4. Change Window Type to Bartlett. 

5. Click Calculation.  

 

 

Adjusting the Plot Tab 

1. From Campbell Diagram dialog, click Plot tab. 

2. Change Graph Type to Color Map (2D). 

3. Change Graph Option to RPM-Order. 

4. Check Draw Order Line. 

5. Adjust the Order Line parameters using the following information. 

▪ Minimum Order: 0 

▪ Maximum Order: 72 
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▪ Gap: 12 

▪ Resolution: 100 

6. In the below-part of the dialog, click Plot to open the graph. The graph will be shown as 

below. 

 

 

Adjusting the Campbell Diagram 

To use Zoom 

1. Drag as below figure to include Order 24. 
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2. The selected part is Zoomed. 

3. From Toolbar, click Initialize View to 

initialize the view.  

 

To use Section View 

1. From Toolbar, click Section View.  

 

2. At the left-side of the Section View, click 

Trace Data.  

 

3. To set the Section, left click in the graph where X, Y is (1134, 24). 

4. Right-click in the Y-Section as shown in the figure below and click Add to Plot in the 

Pop-up menu. 

 

 

5. Y-Section Data is drawn in the Plot. 

 

To use 3D plot 

1. Close the Graph and go back to the Campbell Diagram dialog. 

2. In the Plot tab, change the Graph Type to Surface Contour (3D). 
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3. Click Plot in the below-part of the dialog. 

3D Plot will be shown as figure below. 

 

 

Note: Mouse Operation 

Rotate View: Dragging with left click will rotate the view. 

Translate View: Dragging with left click while pressing Shift key will rotate the view. 

Light Change: Dragging with middle click (mouse scroll button) will change the location of 

the light source. 

 

To adjust the Contour 

1. In the Toolbar, click Contour Legend.  

 

2. Change Style to Smooth. 

3. In the Color Set section, click Color Tool. 

4. In the Color Tool dialog, change Max Value to 8000, click Update and OK. 

5. Contour Legend dialog will be shown as below. 



G E A R B O X  T U T O R I A L  ( D R I V E T R A I N )  

 

48 

 

 

 

6. Click OK to apply the changes. The graph will be shown as below. 

 

Thanks for participating in this tutorial! 
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